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Data and Decisions

ven if you haven’t bought something from H&M recently, chances

are good that you've passed by one of their stores. With over 4000 stores

in 64 markets worldwide, they are one of the largest and fastest-growing
clothing retailers in the world. Over the past decade, H&M has built new
stores at an astounding rate of over 10% a year. Thanks to this growth, the

CEO, Karl-Johan Persson, grandson of the founder, is now the richest person
in Sweden.

Like most companies, H&M’s online presence has been increasing as well.
Of their 64 worldwide markets, 35 offer e-commerce where customers can
shop 24 hours a day, 7 days a week, with just the click of a mouse. H&M now
reaches their customers in ways no one could even imagine just a generation
ago. But what of the future? Will the company be better off continuing to
grow brick and mortar stores at the same pace, or should they devote more
resources into the digital space?!

"We developed this hypothetical example in late 2017 based on our business and consulting experience.
As we were going to press, the news caught up with us. It turns out that indeed H&M had been strug-
gling with their balance of online sales vs. brick and mortar inventory. Perhaps if this book had been
published a year earlier, they could have solved the problem: www.nytimes.com/2018/03/27/business/
hm-clothes-stock-sales.html
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FIGURE 1.1 H&M'’s store growth has
remained steady at just over 10% a
year, but operating profit growth
seems to be coming down.

A few generations ago, many store owners knew their customers and their
business well. With that knowledge, they could forecast growth, see trends,
and even personalize their suggestions to customers, guessing which items that
particular customers might like. Businesses today rely on similar information
to make decisions, but most never meet their customers. With 4000 different
stores and thousands of online customers, H&M has to obtain and analyze
their data in other ways.

The key to turning data into information and knowledge is Statistics—the
collection of tools that extract information from data. These tools that you
will learn also provide the foundation for more advanced methods like data
mining and analytics. According to CEO Karl-Johan Persson, “advanced
analytics provide an important support for our operations. The algorithms we
have started to use will contribute to improvements within everything from
assortment planning and logistics to sales.” Using statistical methods to turn
data into information, information into knowle d knowledge into smart
business decisions is the key to all successful siness enterprises.

And it all starts . . . with data.

homasine has just landed her first j ] b ~ school asa marketmg and strategy

owth in stores vs. overall operating
profit growth

0 -
15 —/’\/_/\
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Thomasine wonders if the decline she sees in the stores’ profit growth (the blue
line in Figure 1.1) means she should recommend putting more resources into
online sales instead of just building more stores.

Displays like this, called data visualizations, can summarize large amounts of
data in a concise way that helps make good business decisions, and can often reveal
things that weren’t expected.

IN PRACTICE 1.1 Business insights from visualizations

One of the authors was consulting for a large multinational firm and was given access
to their sales data. Management wondered if there might be sales opportunities
around the world and where they might be. Because the company sold many consumer
items to individuals, the consultant decided that rather than focus on the total sales

22016 H&M Group annual report, about.hm.com/en/media/news/financial-reports/2017/1/2441626.html
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(in dollars) in each country he should divide the total sales in each country by the
population size, creating the new variable Sales per Capita. When he displayed this
variable on a map, management was shocked:?

We know that we sell more in the United States than anywhere else in
the world, but why are some countries redder than the U.S.?

(IR UREVEN In this color scheme, low Sales per Capita ($ spent per customer) is
indicated by dark blue, average by white (grey) and higher than average by red. The
countries in the brightest red are the ones with the highest sales per person.

m You mean we sell more per person in Norway, Finland, and even Australia
than in the U.S.?

HILBUREVEN Exactly. Norway has the highest sales at more than $600 per person,
compared with the U.S. at $364.

m Wow! I had no idea. I never would have guessed that. Thank you for
the insight!

Sales per Capita

600
[ 500
400

- 300

200
100
0

Ve will be using visualizations, summaries, and models of data to understand,
xplain, and predict throughout the course. Along the way we will encounter many

es of data and corresponding ways to visualize, model, and analyze the data we
collect. And because it all starts with data, we’ll spend the rest of this chapter get-
ting to know more about the nature of data.

Data

Every time you make an online purchase, more information is captured than just
the details of the purchase itself. What pages did you search to get to your purchase?
How much time did you spend looking at each? These recorded values, whether
numbers or labels, together with their context are called data. They are recorded
and stored electronically, in vast digital repositories called data warehouses.
Businesses have always relied on data to make good decisions, but today, more than
ever before, companies use data to make decisions about virtually all aspects of
their business, from inventory to advertising to website design.

This is based on a true story. We can’t reveal the name of the company due to a non-disclosure
agreement.
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-

Why are you taking this course?

The typical answer is “because it’s
required.” But why is it required?
Because these are the tools that
will help you leverage your busi-

ness domain knowledge with data.

J

Albert Einstein is credited with
saying “If I had one hour to save
the world, I'd spend 55 minutes
defining the problem and 5 min-
utes solving it.”* The wisdom of
using your business acumen to
define your question will be clear

throughout this book.

Plan (1-2)

1. Define the problem.

2. Collect and/or find data and
identify the variables.

Do (3-6)
3. Prepare and wrangle data.
4. Characterize the data.
5. Explore the data.
Summarize
Visualize
6. Model (if appropriate).
Check conditions and
assumptions for modeling.
Fit the model and make the
necessary calculations.

Report (7)

7. Communicate and present.

\ 7

Every swipe of your credit card and every click of your mouse has helped
these data warehouses grow. The challenges of collecting, managing, storing, and
curating all of this information collectively fall under the term Big Data.

But data alone can’t make good decisions. To start the process of turning data
into useful information, you first need to know what decisions you want to make.
Without a question, you have no idea what might be interesting about the data.
Should you look at the time of transactions, their location, their price, which prod-
ucts were bought, or something else? Your knowledge of the business issues and
the questions you want to answer will help guide your search for insights from the
data, and help you harness data to make better decisions.

Once you have data and a clear vision of the problem, the statistics tech-
niques in this book can empower your decision making. They will help you in two
ways: You’ll learn how to estimate the likely values needed for your decisions
and—possibly more important—you’ll learn how to quantify the uncertainty of
those estimates.

Before H&M introduces a new product they usually test market it to a small
sample of customers and collect data on the producgsperformance before commit-
ting to it worldwide. Statistics helps them ma ap from a sample to an
understanding of the world at large. We hop t ill empower you to draw
conclusions from data and make valid busine cisions in response to such ques-
tions as:

e Will the new design of our website inetre
more sales?

e What is the effect of adyg

Do aggressive, “high-grog

more conservative funds?

click-through rates and result in

sales?
mutual funds really have higher returns than

® [s there a seaso in your firm’s profits?

* Whatis the between shelf location and cereal sales?

* Do studen the world perceive issues in business ethics differently?
L]

@ 1on characteristics about your customers and why they choose
¢?—and, more importantly, are those characteristics the same
ho aren’t your customers?

ability to answer questions such as these and make sound business

s with data depends largely on your ability to take a business problem,

ate it into a question that data can answer, and communicate that answer

others. The steps to follow are shown in the box in the margin. The Plan, Do,

and Report strategy is found throughout the book. The main headings will stay

the same although the specific subparts will vary slightly depending on the topic
we’re learning.

Rarely does the journey from problem definition to solution proceed straight
from Step 1 to Step 7. As you learn more about your data you’ll probably want
to rethink earlier steps, possibly even modifying the original question itself. Or
you may decide to collect different data after you see the limitations of your
current model. But bearing this process in mind will help you to strategize your
data analytics process and keep you on the road toward the goal of delivering
good decisions.

*According to quoteinvestigator.com there is “no substantive evidence that Einstein ever made a
remark of this type.” It appeared in a paper by William H. Markle, who credited an unnamed Yale
professor. But many people, including those at goodreads.com, still give the credit to Einstein.
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Plan
1. Define problem 3. Prepare data
4. Characterize data
2. Collect/Find data 3, Explore data

ITERATE

The Role of Data in Decision Making

What is analytics?

Analytics is the term for
extracting information from
data.

Is there really a difference
between statistics and
analytics?

Essentially no. We’ll use the
terms interchangeably. Some
use the term “advanced
analytics” to include modern
machine learning methods
not traditionally found in
statistics. (See Chapter 21)

THEW’S:

WHO
WHAT
WHEN
WHERE
WHY

When companies try to obtain actionable information from data that may have
been collected in the course of doing business (such as records of transactions or a
customer database) it is usually called data mining. Sometimes the analysis is
called predictive analytics if it focuses on future performance. The more general
term, business analytics (or sometimes simply analytics), refers to any use of data
and statistical analysis to inform business decisiéns./].eading companies are embrac-
ing analytics to extract value from their ve Humby, author of The Loyalty
Myth, said, “data is the new oil.” Foge , Zillow recently offered $1,200,000
i : prices from publicly available data. As of
e prize.
about nearly every aspect of their busi-
r of customers and predicting their responses,
customers and to compete more effectively.
sed analytics to examine its own use of computer
ious to its own technical people, once they crunched

Companies use data to
ness. By studying the p
they hope to better se

eBay collected data
resources. Alth not o

the data ¢ uge inefficiencies. According to Forbes, eBay was able to
“save millio al expenditures within the first year.”
Da many forms. Some are numerical (consisting only of numbers),

ome
: % abetic (consisting only of letters), and yet others are alphanumerical
\bers and letters). But data are useless unless we know their context.

aper journalists know that the lead paragraph of a good story should estab-

“Five W’s”: who, what, when, where, and (if possible) why. Often, we add how

o the list as well. Answering these questions connects the data to the business

oblem at hand. The answers to the first two questions are essential. If we don’t
know who and what, we don’t have any useful information.

We can make the meaning clear if we add the context of who the data are
about and what was measured and organize the values into a data table. Table 1.1
shows part of a data table of purchase records from an online music retailer. Each
row represents a purchase of a music album. The most general term for a row of a
data table is case or record. Each column of the table records some characteristic

Order Number Name State/Country | Price | Area Code = Album Download @ Gift? Stock ID Artist
105-2686834-3759466 = Katherine H. | Ohio 5.99 440 Identity N B00000I5Y6 | James Fortune & Flya
105-9318443-4200264 = Samuel P. [llinois 9.99 312 Port of Morrow Y B000002BK9 | The Shins
105-1872500-0198646 | Chris G. Massachusetts 9.99 413 Up All Night N B000068ZVQ | Syco Music UK
103-2628345-9238664 | Monique D. Canada 10.99 902 Fallen Empires N BO000010AA | Snow Patrol
002-1663369-6638649 | Katherine H. | Ohio 11.99 440 Sees the Light N B0O02MXA7Q0 | La Sera

TABLE 1.1 Example of a data table. The variable names are in the top row. Typically,

the Who of the table are found in the leftmost column.
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.
Metadata

Metadata became a common term
when the National Security
Agency (NSA) claimed that they
weren’t collecting Americans’
phone calls but only the informa-
tion about the phone calls, the
phone numbers of the caller and
recipient, the time and duration of
the call and any bank information
used to make the call—in other
words—the metadata.

CHAPTER 1 Data and Decisions

of the cases. The columns are called variables. You’ll usually find the name of the
variable at the top of the column as in Table 1.1.

We call cases by different names, depending on the situation. Individuals who
answer a survey are referred to as respondents. People on whom we experiment are
subjects or (in an attempt to acknowledge the importance of their role in the experi-
ment) participants, but animals, plants, websites, and other inanimate subjects are
often called experimental units. Often we call cases just what they are: for example,
customers, economic quarters, or companies. When referring to a transaction, rows are
often called records. In Table 1.1, the rows are the individual orders, or purchase
records. A common place to find the who of the table is the leftmost column. It’s
often an identifying variable for the cases, in this example, the order number.

JUST CHECKING

1 What is the “who” of Table 1.1? That is, does each row refer to a) a person or
b) an order? How can you tell?

If you collect the data yourself, you’ll kwowiwhat'the cases are and how the
variables are defined. But, often, you’ll be looking at data that someone else col-
lected. The information about the datag€alled e metadata, might have to come
from the company’s database administrator ptfrom the information technology
department of a company. Metadata'gypically contains information about how,
when, and where (and possibly why) gheldata were collected; who each case repre-
sents; and the definitions of all thejvariables.

A general term for a dataytable like the one shown in Table 1.1 is a spread-
sheet, a name that comes from beokkeeping ledgers of financial information. The
data were typically spread across facing pages of a bound ledger, the book used by
an accountant forkeeping/records of expenditures and sources of income. For the
accountant, th€%olumns were the types of expenses and income, and the rows
were transactions, typically invoices or receipts. These days, it is common to keep
modest-sizéidatasets in a spreadsheet even if no accounting is involved. It is usually
easy t@'move @data table from a spreadsheet program to a program designed for
statiStical graphics and analysis, either directly or by copying the data table and
pasting ipinto the statistics program.

Although data tables and spreadsheets are great for relatively small data sets,
they"are cumbersome for the complex data sets that companies must maintain on a
day-to-day basis. Try to imagine a spreadsheet from a company the size of Amazon
with customers in the rows and products in the columns. Amazon has hundreds of
millions of customers and millions of products. But very few customers have pur-
chased more than a few dozen items, so almost all the entries in the spreadsheet
would be blank—not a very efficient way to store information. For that reason,
various other database architectures are used to store data. The most common is a
relational database.

In a relational database, two or more separate data tables are linked together
so that information can be merged across them. Each data table is a relation because
it is about a specific set of cases with information about each of these cases for all
(or at least most) of the variables (“fields” in database terminology). For example, a
table of H&M customers, along with demographic information on each, is such a
relation. A data table of all the items sold by the company, including information
on price, inventory, and past history, is another relation. Transactions may be held
in a third “relation” that references each of the other two relations. Table 1.2 shows
a small example.

In statistics, analyses are typically performed on a single relation because all
variables must refer to the same cases. But often the data must be retrieved from a
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relational database. Retrieving data from these databases may require specific
expertise with that software. In the rest of the book, we’ll assume that the data have
been retrieved and placed in a data table or spreadsheet with variables listed as
columns and cases as the rows.

( Customers )
Customer
Number Name City State = ZIP Code | Customer since | Gold Member?
473859 R.De Veaux | Williamstown MA 01267 2007 No
127389 N. Sharpe New York City NY 10021 2000 Yes
335682 P.Velleman | Ithaca NY 14580 2003 No
L J
( ltems )
Product ID Name Pri Currently in Stock?
42-8719 Resort Shirt Yes
73-2671 Lace Dress 69¢ No
35-0518 Cashmere S .00 Yes
72-9665 69.00 Yes
( ransactions )
Transaction : Shipping
Number Date ber Product ID = Quantity Method Free Ship?
123478923 5/17 859 42-8719 1 UPS 2nd Day N
7 | 473859 35-0518 1 UPS 2nd Day N
335682 73-2671 3 UPS Ground N
127389 72-9665 1 Fed Ex Ovnt Y

IN PRACTICE 1.2 Gaining insight from data by identifying
variables and the W’s

Carly is an analyst at a credit card issuer. Her manager wants to know if an offer

mailed 3 months ago has affected customers’ use of their cards. To answer, Carly asks

the I'T department to assemble some data on recent customer spending. The I'T

department sends her a spreadsheet. The first six rows look like this:

( )
Account Pre Segment

D Spending ~ Spending Age Segment  Enroll? Offer Spend

393371 | $2,698.12 | $6,261.40 | 25-34 | Travel/Ent = NO None $887.36
462715 | $2,707.92 | $3,397.22 @ 45-54 | Retail NO Gift Card $5,062.55
433469 $800.51 = $4,196.77 65+ | Retail NO None $673.80
462716 | $3,459.52 | $3,335.00 | 25-34 | Services YES | Double Miles $800.75
420605 | $2,106.48 | $5,576.83 | 35-44 | Leisure YES | Double Miles | $3,064.81
473703 | $2,603.92 @ $7,397.50 = <25 | Travel/Ent = YES Double Miles $491.29

| J

(continued)
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1.3

m Thanks for the information. ’'m not quite sure about the structure. Can

you tell me what each row represents and what was measured on each?

The cases are individual customers. The data are from our
internal records for the past 6 months (3 months before and 3 months after an offer
was sent to the customers). The variables include the account ID of the customer
(Account ID), and the amounts charged on the card before (Pre Spending) and after
(Post Spending) the offer was sent out. We also have the customer’s Age, marketing Seg-
ment, whether they enrolled on the website (Enro/l?), what offer they were sent (Offer),
and how much they charged on the card in their marketing segment (Segmzent Spend).
(The marketing Segment classifies cardholders based on their spending patterns.)

Variable Types

When the values of a variable are simply the names of categories we call it a cate-
gorical, or qualitative, variable. When the values of a variable are measured
numerical quantities, we call it a quantitative va

Descriptive responses to questions are
responses to the questions “What type of mu
kind of advertising does your firm use?”
cial case of categorical variables is one tha
“yes” or “no”), which arise natur,
stock market?” or “Do you make o

gories. For example, the

d do you invest in?” or “What

orical values. An important spe-

ly two possible responses (usually

stions like “Do you invest in the
purchases from this website?”

Question

Do you invest in the stock market? es__No
What kind of advertising do you use?
What is your class at school?

[ would recommend this course to anothee's

Categori esponses

spapers __ Internet __ Direct mailings
__ Freshman __ Sophomore __ Junior __ Senior

__ Strongly Disagree __ Slightly Disagree __ Slightly Agree __ Strongly Agree

__ Very Unsatisfied __ Unsatisfied __ Satisfied __ Very Satisfied

Categorical or Quantitative?

Dates can be confusing. Dependin
on how a date is used, it may be
categorical or quantitative. For
example, Day of the Week has no
units, and is categorical. What
about a date such as October 31,
2017 (which is a string of charac-
ters)? Most software will treat this
as categorical. However, many sta-
tistics programs can add and sub-
tract dates to determine that there
are 60 days between 10/30/17 and
12/30/17, and that 11/30/17 falls
exactly in the middle of this date
range. Most programs can convert
any date into the number of sec-
onds, minutes or hours past a
given starting date. If this is the
case, then dates may be treated as
a quantitative variable, but be sure
to specify the units.

ny measurements are quantitative. In a purchase record, price, quantity,
1me spent on the website are all quantitative values with units (dollars, count,
d seconds). For quantitative variables, the units tell how each value has been
measured. Even more important, units such as yen, cubits, carats, angstroms, nano-
seconds, miles per hour, or degrees Celsius tell us the scale of measurement, so we
know how far apart two values are. Without units, the values of a measured vari-
able have no clear meaning. It does little good to be promised a raise of 5000 a year
if you don’t know whether it will be paid in euros, dollars, yen, or Estonian krooni.
An essential part of a quantitative variable is its units. Some quantitative variables,
however, don’t have obvious units. The Dow Jones Industrial “Average” has units
(points?) but no one talks about them. Percentages are ratios of two quantities and
so the units “cancel out,” but they are still percentages of something. So, although
it isn’t imperative that a quantitative variable have explicit units, when they are not
explicit, be careful to think about whether adding their values, averaging them, or
otherwise treating them as numerical, makes sense.

The distinction between categorical and quantitative variables seems clear, but
there are reasons to be careful. First, some variables can be considered as either
categorical or quantitative, depending on the kind of questions we ask about them.
For example, the variable Age would be considered quantitative if the responses
were numerical and they had units. A doctor would certainly consider Age to be
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Area Codes?

When area codes were first
introduced all phones had dials.
To reduce wear and tear on the
dials and to speed calls, the
lowest-digit codes (the fastest to
dial—those for which the dial
spun the least) were assigned to
the largest cities. So, New York
City was given 212, Chicago 312,
LA 213, and Philadelphia 215, but
rural upstate New York was 607,
Joliet was 815, and San Diego 619.
Back then, the numerical value of
an area code could be used to
guess something about the popu-
lation of its region. But after dials
gave way to push buttons, new
area codes were assigned without
regard to population and area
codes are now just categories, with
no quantitative information.

Variahle Names That Make
Sense

A tradition still hangs on in some
places to name variables with
cryptic abbreviations in uppercase
letters. This can be traced back to
the 1960s, when computer
grams were controlled wi
instructions punched on cards.
The earliest punch card equip
ment used only uppercase letters,
and statistics programs limited
variable names to six or eight
characters, so variables had names
like PRSRF3. Modern programs
don’t have such restrictive limits,
so there is no reason not to use
names that make sense.
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quantitative. The units could be years, or for infants, the doctor would want even
more precise units, like months, or even days. On the other hand, a retailer might
lump together the values into categories like “Child (12 years or less),” “Teen (13
to 19),” “Adult (20 to 64),” or “Senior (65 or over).” For many purposes, like know-
ing which song download coupon to send you, that might be all the information
needed. Then Age would be a categorical variable.

How to classify some variables as categorical or quantitative may seem obvi-
ous. But be careful. Area codes may look quantitative, but are really categories.
What about ZIP codes? They are categories too, but the numbers do contain
information. If you look at a map of the United States with ZIP codes, you’ll see
that as you move West, the first digit of ZIP codes increases, so treating them as
quantitative might make sense for some questions. Area codes present a similar set
of issues; see the sidebar.

Another reason to be careful about classifying variables comes from the analy-
sis of Big Data. When analysts want to decide what advertisement to send to the
web page you’re looking at, or what the probability is that you'll renew your phone
contract, they use automatic methods involvimg dozens or even hundreds of vari-
ables. Usually the software used to do the a as to guess the type of variable
from its values. When the variable cont s other than numbers, the soft-
ware will correctly type the variable as'eafeg@rical, but just because a variable has
numbers doesn’t mean it is quan e. ’ve seen examples (area code, order

‘£

number) where that’s just not the ¢ miners spend much of their time going
back through data sets to corfec variables as categorical or quantitative to
avoid silly mistakes of misuse:

Identifiers

A special Kind tegorical variable is worth mentioning. Identifier variables are
categorical vaiables whose only purpose is to assign a unique identifier code to
each i the data set. Your student ID number, social security number,

ber are all identifiers.

variables are crucial in this era of Big Data because, by uniquely iden-
the cases, they make it possible to combine data from different sources and
vide unique labels. Your school’s grade transcripts and your bursar bill records
¢ kept separately, but both refer to you. Your student ID is what links them.
ost companies keep such relational databases. The identifier is crucial to linking
one data table to another in a relational database. The identifiers in Table 1.2
are the Customer Number, Product ID, and Transaction Number. Variables like UPS
Tracking Number and Social Security Number are other examples of identifiers.

Other Data Types

AirBnB, like many travel sites, uses stars to rate their listings. But are star ratings
categorical or quantitative? There is certainly an order of perceived worth; more
stars indicate higher perceived worth. An AirBnB property whose customer
responses average around 4 stars is better than one whose average is around 2, but is
it twice as good? These values are not quantitative, so we can’t really answer that
question. When the values of a categorical variable have an intrinsic order, we can
say that the variable is ordinal. By contrast, a categorical variable with unordered
categories is sometimes called nominal. Values can be individually ordered (e.g.,
the ranks of employees based on the number of days they’ve worked for the com-
pany) or ordered in classes (e.g., Freshman, Sophomore, Junior, Senior). Ordering
is not absolute; how the values are ordered depends on the purpose of the ordering.
For example, are the categories Infant, Youth, Teen, Adult, and Senior ordinal?
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2007
2008
2009
2010
2011
2012
2013
2014
2015
2016

|\

Year | Total Revenue (in $B)

9.44
10.38

9.77
10.71
11.70
13.30
14.79
16.44
19.16
21.31

J

TABLE 1.4 Starbucks’s total
revenue (in $B) for the years

2007 to 2016.

1.4

Well, if we are ordering on age, they surely are and how to order the categories
is clear. But if we are ordering on purchase volume, it is likely that either Teen or
Adult will be the top group.’

Cross-Sectional and Time Series Data

The quantitative variable Total Revenue in Table 1.4 is an example of a time series.
A time series is an ordered sequence of values of a single quantitative variable
measured at regular intervals over time. Time series are common in business. Typi-
cal measuring points are months, quarters, or years, but virtually any consistently
spaced time interval is possible. Variables collected over time hold special chal-
lenges for statistical analysis, and Chapter 20 discusses these in more detail.

By contrast, most of the methods in this book are better suited for cross-
sectional data, where several variables are measured at the same time point. If we
collect data on sales revenue, number of customers, and expenses for last month at
each Starbucks (more than 25,000 locations as of 2017) at one point in time, these
would be cross-sectional data. Cross-sectional datasmay contain some time infor-
mation (such as dates), but they aren’t a time serie%e they aren’t measured at
regular intervals. Because different method o analyze these different
types of data, it is important to be able to @r both time series and cross-

sectional data sets.

IN PRACTICE 1.3 Identifying the types of variables

m I want to unders . l e data we've collected. How should we begin?

? — categorical (nominal)
er — categorical (nominal)
Segment Spend - quantitative (units $)

All these data are cross-sectional. We do not have successive values over time.

Data Sources: Where, How, and When

We must know who, what, and why to analyze data. Without knowing these three,
we don’t have enough to start. Of course, we’d always like to know more because
the more we know, the more we’ll understand and the better our decisions will be.
If possible, we’d like to know the where, how, and when of data as well.

5Some people differentiate quantitative variables according to whether their measured values have a
defined value for zero. This is a technical distinction and usually not one we’ll need to make. (For example,
itisn’t correct to say that a temperature of 80°F is twice as hot as 40°F because 0° is an arbitrary value.
On the Celsius scale those temperatures are 26.67°C and 4.44°C—a ratio of 6.) The term interval scale
is sometimes applied to quantitative variables that lack a defined zero, and the term ratio scale is applied
to measurements for which such ratios are appropriate.
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Values recorded in 1947 may mean something different than similar values
recorded last year. Values measured in Abu Dhabi may differ in meaning from
similar measurements made in Mexico. Conclusions drawn about data collected
from a store in Singapore last spring may not apply to other locations, or other
seasons. Knowing how, when, where, and why the data were collected can mean
the difference between valid and spurious conclusions.

How the data are collected can make the difference between insight and non-
sense. As we’ll see later, data that come from a voluntary survey on the Internet are
almost always worthless. In a recent Internet poll, 84% of respondents said “no” to
the question of whether subprime borrowers should be bailed out. While it may
be true that 84% of those 23,418 respondents did say that, it’s dangerous to assume
that that group is representative of any larger group. To make inferences from the
data you have at hand to the world at large, you need to ensure that the data you
have are representative of the larger group. Chapter 8 discusses sound methods
for designing a survey or poll to help ensure that the inferences you make are valid.

Another way to collect valid data is by performing an experiment in which you
actively manipulate variables (called factors)mo see what happens. Most of the
“junk mail” credit card offers that you reccives@are actually experiments done by
marketing groups in those companies #T'Hey mdy make different versions of an
offer to selected groups of customers togee which one works best before rolling
out the winning idea to the entirg”custofiér base. Chapter 9 discusses both the
design and the analysis of experiments like these.

Sometimes, the answer t6 aquestion you may have can be found in data that
someone or some organizatioft hasalready collected. Internally, companies may
analyze data from theirfownjdatabases or data warehouse. They may also supple-
ment or rely entirely on'data collected by others. Many companies, nonprofit orga-
nizations, and goyernmentiagencies collect vast amounts of data via the Internet.
Some organizafions may charge you a fee for accessing or downloading their data.
The U.S. goyerfiment collects information on nearly every aspect of life in the
United Sgates, both social and economic (see, for example, www.census.gov, or more
generally, www.usa.gov), as the European Union does for Europe (see ec.europa.eu/
eup@Stat). International organizations such as the World Health Organization (www
#vho.org) and polling agencies such as Pew Research (www.pewresearch.org) offer
information on a variety of current social and demographic trends. Data like these
argusually collected for different purposes than to answer your particular business
question. So you should be cautious when generalizing from data like these.
Unless the data were collected in a way that ensures that they are representative
of the population in which you are interested, you may be misled. Chapter 21
discusses data mining, which attempts to use Big Data to make hypotheses and
draw insights.

There’s a World of Data on the Internet

These days, one of the richest sources of data is the Internet.
With a bit of practice, you can learn to find data on almost any
subject. We found many of the data sets used in this book by
searching on the Internet. The Internet has both advantages and
disadvantages as a source of data. Among the advantages are the
fact that often you’ll be able to find even more current data than
we present. One disadvantage is that references to Internet
addresses can “break” as sites evolve, move, and die. Another
disadvantage is that important metadata—information about the
collection, quality, and intent of the data—may be missing.

Our solution to these challenges is to offer the best advice
we can to help you search for the data, wherever they may be

residing. We usually point you to a website. We’ll sometimes
suggest search terms and offer other guidance.

Some words of caution, though: Data found on Internet sites
may not be formatted in the best way for use in statistics soft-
ware. Although you may see a data table in standard form, an
attempt to copy the data may leave you with a single column of
values. You may have to work in your favorite statistics or
spreadsheet program to reformat the data into variables. You will
also probably want to remove commas from large numbers and
such extra symbols as money indicators ($, ¥, £, €); few statistics
packages can handle these.
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JUST CHECKING

An insurance company that specializes in ¢
property insurance has a separate datal

cies that involve churches and sc
portion of that database.

ols

Throughout this book, we often provide a margin note for a new dataset list-
ing some of the W’s of the data. When we can, we also offer a reference for the
source of the data. It’s a habit we recommend. The first step of any data analysis is
to know why you are examining the data (what you want to know), whom each row
of your data table refers to, and what the variables (the columns of the table)
record. These are the Why, the Who, and the What. Identifying them is a key part
of the Plan step of any analysis. Make sure you know all three before you spend

time analyzing the data.

IN PRACTICE 1.4 Identifying data sources

On the basis of her initial analysis, Carly asks her colleague Ying Mei to e-mail a
sample of customers from the Travel and Entertainment segment and ask about their
card use and household demographics. Carly asks another colleague, Gregg, to design
a study about their double miles offer. In this study, arandom sample of customers
receives one of three offers: the standard double mile§ offerya double miles offer good

on any airline; or no offer.

m It looks like we have three sour t data for our customer spending
1 an em all the same way?

tion. Ying Mei’s data come from a designed

analysis. How are they different and will
ative of our customers. Gregg’s data come from

ALLINEAN(HLG{AAN My data set w,
allow us to decide which of these offers will work

survey, so it should be represe
a designed experiment, which
the best.

2 List as many of the W’s as you can for this data set.

3 Classify each variable as to whether you think it should
be treated as categorical or quantitative (or both); if
quantitative, identify the units.

Years
Policy Number  Claim Free

4000174699
8000571997
8000623296
3000495296
5000291199
8000470297
1000042399
4000554596
3000260397
8000333297
4000174699

[ =T =T~ CY "N U R

Net Property  Net Liability = Total Property = Median Age
Premium (§)  Premium ($)  Value ($000) in ZIP Code ~ School?  Territory Coverage
3107 503 1036 40 FALSE AL580 BLANKET
1036 261 748 42 FALSE PA192 | SPECIFIC
438 B8 344 30 FALSE ID60 BLANKET
582 339 270 35 TRUE NC340 | BLANKET
993 357 218 43 FALSE 0K590 = BLANKET
433 622 108 31 FALSE NV140 BLANKET
2461 1016 1544 41 TRUE NJ20 BLANKET
7340 1782 5121 44 FALSE FL530 BLANKET
1458 261 1037 42 FALSE NC560 BLANKET
392 351 177 40 FALSE OR190 | BLANKET
3107 503 1036 40 FALSE AL580  BLANKET
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(@ WHAT CAN GO WRONG?

* Don’t label a variable as categorical or quantitative without thinking about the
data and what they represent. The same variable can sometimes take on dif-
ferent roles.

* Don’t assume that a variable is quantitative just because its values are numbers.
Categories are often given numerical labels. Don’t let that fool you into
thinking they have quantitative meaning. Look at the context.

* Always be skeptical. One reason to analyze data is to discover the truth. Even
when you are told a context for the data, it may turn out that the truth is a
bit (or even a lot) different. The context colors our interpretation of the
data, so those who want to influence what you think may slant the context.
A survey that seems to be about all students may in fact report just the opin-
ions of those who visited a fan website. The question that respondents

answered may be posed in a way that infl@ responses.

ETHICS IN ACTION

arah Potterman, a doctoral student in educational psy-

chology, is researching the effectiveness of various inter-

ventions recommended to help children with learning
disabilities improve their reading skills. One parti
intriguing approach is an interactive software syste h@
analogy-based phonics.

Sarah contacted the company that deve
ware, RSPT Inc., to obtain the system fr
in her research. RSPT Inc. expressed
compare its product with other interve
quite confident that its approach/wo
Not only did the compa Vi

but RSPT Inc. also ge
with a grant to cover her data c

this soft-
s for use
aving her
tegies and was
beithe most effective.
with free software,
fered to fund her research
ction and analysis costs.

¢ |dentify the ethical dilemma in this scenario.
e What are the undesirable consequences?

¢ Propose an ethical solution that considers the welfare of all
stakeholders.

Jim Hopler is operations manager for a local office of a
top-ranked full-service brokerage firm. With increasing com-
petition from both discount and online brokers, Jim’s firm
has redirected attention to attaining exceptional customer
service through its client-facing staff, namely brokers. In par-
ticular, management wished to emphasize the excellent advi-
sory services provided by its brokers.

Results from surveying clients about the advice received
from brokers at the local office revealed that 20% rated it

or, 5% tated it below average, 15% rated it average, 10%
@ it above average, and 50% rated it outstanding. With
orporate approval, Jim and his management team instituted
several changes in an effort to provide the best possible advi-
sory services at the local office. Their goal was to increase the
percentage of clients who viewed their advisory services as
outstanding.

Surveys conducted after the changes were implemented
showed the following results: 5% poor, 5% below average,
20% average, 40% above average, and 30% outstanding. In
discussing these results, the management team expressed
concern that the percentage of clients who considered their
advisory services outstanding fell from 50% to 30%.

One member of the team suggested an alternative way of
summarizing the data. By coding the categories on a scale
from 1 = poor to 5 = outstanding and computing the aver-
age, they found that the average rating increased from 3.65
to 3.85 as a result of the changes implemented. Jim was
delighted to see that their changes were successful in improv-
ing the level of advisory services offered at the local office. In
his report to corporate, he only included average ratings for
the client surveys.

¢ Identify the ethical dilemma in this scenario.

e What are the undesirable consequences?

¢ Propose an ethical solution that considers the welfare of all
stakeholders.
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FROM LEARNING TO EARNING

LEARNING
OBJECTIVES

TERMS
Big Data

Business analytics
Case

Categorical (or qualitative)
variable

Context
Cross-sectional data
Data

Data mining (or predictive
analytics)

Data table

Data warehouse

Experimental unit

Identifier variable

Metadata

Nominal variable

Understand the business context of the data and the problem you are trying to solve to he successful
when making decisions from data.

* Who, what, why, where, when (and how)—the W’s—help nail down the context of the data.

* We must know who, what, and why to be able to say anything useful based on the data. The

who are the cases (or records or rows). The what are the variables. A variable gives informa-
tion about each of the cases. The why helps us decide which way to treat the variables.

* Stop and identify the W’s whenever you have data, and be sure you can identify the cases
and the variables.

Identify whether a variable is being used as categorical or quantitative.
* Categorical variables identify a category for each case. Us% think about the counts

of cases that fall in each category. (An exception is an i riable that just names
each case.)

* Quantitative variables record measurements or am mething; they must have units.

e data were collected. That can help you
e data.

al or quantitative depending on what
’t be pigeonholed as one type or

* Sometimes we may treat the same variable as cz
we want to learn from it, which means so
the other.

Consider the source of your data and the rea
understand what you might be able to learn

large and complex that traditional methods typically brought
helmed.

y tells who was measured, what was measured, how the data were collected, where the
ected, and when and why the study was performed.

Data taken from situations that vary over time but measured at a single time instant are said to be a
cross-section of the time series.

Recorded values, whether numbers or labels, together with their context.

The process of using a variety of statistical tools to analyze large databases or data warehouses.

An arrangement of data in which each row represents a case and each column represents a variable.

A large database of information collected by a company or other organization usually to record transac-
tions that the organization makes, but also used for analysis via data mining.

An individual in a study for which or for whom data values are recorded. Human experimental units are
usually called subjects or participants.

A categorical variable that records a unique value for each case, used to name or identify it.

Auxiliary information about variables in a database, typically including how, when, and where (and possi-
bly why) the data were collected; who each case represents; and the definitions of all the variables.

The term “nominal” can be applied to a variable whose values are used only to name categories.



Ordinal variable
Participant
Quantitative variable

Record
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The term “ordinal” can be applied to a variable whose categorical values possess some kind of order.
A human experimental unit. Also called a subject.
A variable in which the numbers are values of measured quantities with units.

Information about an individual in a database.

Relational database A relational database stores and retrieves information. Within the database, information is kept in data

tables that can be “related” to each other.

Respondent Someone who answers, or responds to, a survey.
Spreadsheet A spreadsheet is a layout designed for accounting that is often used to store and manage data tables.
Excel is a common example of a spreadsheet program.
Subject A human experimental unit. Also called a participant.
Time series Data measured over time. Usually the time intervals are equally spaced or regularly spaced (e.g., every
week, every quarter, or every year).
Units A quantity or amount adopted as a standard of measurement, such as dollars, hours, or grams.
Variable A variable holds information about the same characteristic fo ases.

TECH SUPPORT Entering Data

These days, nobody does statistics by hand. We use technol- @ ges can take the variable names from the first row

ogy: a programmable calculator or a statistics program on a autématically.

computer. Professionals all use a statistics package desig@ e Excél is often used to help organize, manipulate, and pre-

for the purpose. We will provide many examples of résults pare data for other software packages. Many of the other
packages take Excel files as inputs. Alternatively, you can

choosing one in particular, we'll offer generic res k copy a data table from Excel and Paste it into many pack-
like those produced by all the major statistics out ages, or export Excel spreadsheets as tab delimited (.txt) or
don’t exactly match any of them. Then, in pport comma delimited files (.csv), which can be easily shared
section at the end of each chapter, we'll or get- and imported into other programs. All data files provided

ting started on several of the major p with this text are in tab-delimited text (.txt) format.

To open a file containing data in Excel:

0 know to do what
return, you can
packages pretty easily.

If you understand what the ¢ ut
you want and what it needg'to s
figure out the specific deta mo

For example, to get your data i
age, you need to tell the computer:

computer statistics pack- e Choose File > Open.

e Browse to find the file to open. Excel supports many file
e Where to find the data. This usually means directing the formats.
computer to a file stored on your computer’s disk or to data °
on a database. Or it might just mean that you have copied
the data from a spreadsheet program or Internet site and it
is currently on your computer’s clipboard. Usually, the data
should be in the form of a data table with cases in the rows
and variables in the columns. Most computer statistics
packages prefer the delimiter that marks the division
between elements of a data table to be a tab character
(comma is another common delimiter) and the delimiter

that marks the end of a case to be a return character.

Other programs can import data from a variety of file
formats, but all can read both tab delimited (.txt) and
comma delimited (.csv) text files.

e You can also copy tables of data from other sources, such as
Internet sites, and paste them into an Excel spreadsheet.
Excel can recognize the format of many tables copied this
way, but this method may not work for some tables.

e Excel may not recognize the format of the data. If data
include dates or other special formats ($, €, ¥, etc.), identify
the desired format. Select the cells or columns to reformat
and in the Home menu choose Home > Format > Format Cells
(found under Cells). Often, the General format is the best
option for data you plan to move to a statistics package.

e Where to put the data. (Usually this is handled automatically.)

e What to call the variables. Some data tables have variable
names as the first row of the data, and often statistics
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To import a text file:

e Choose File > Open and select the file from the dialog. At
the bottom of the dialog screen you’ll see Open As:—be
sure to change to Data with Preview. This will allow you to
specify the delimiter and make sure the variable names are
correct. (JMP also allows various formats to be imported
directly, including .xls files.)

You can also paste a data set in directly (with or without
variable names) by selecting:

e File > New > Data Table and then Edit > Paste (or Paste
with Column Names if you copied the names of the variables
as well).

Finally, you can import a data set from a URL directly by
selecting:

e File > Internet Open and pasting in the address of the web-
site. JMP will attempt to find data on the page. It may take
a few tries and some edits to get the data set in correctly.

To import a text or Excel file:

e Choose File > Open. From Files of type, choose Text (*.txt) or
Excel (*.xlIs; *xlIsx).

e Browse to find and select the file.

e |n the lower right corner of the dialog, choose Open to
open the data file.

e Click Open.

R can import many types of files, but text files (
delimited) are easiest. If the file is tab delimited an
the variable names in the first row, then:

or c
ontains

> mydata = read.delim(file.

will give a dialog where you can pick the file you want to
import. It will then be in a data frame called mydata. If the
file is comma delimited, use:

> mydata = read.csv(file.choose())

COMMENTS

RStudio provides an interactive dialog that may be easier to
use. For other options, including the case that the file does
not contain variable names, consult R help.

To import a text file:

e Choose File > Open > Data. Under “Files of type,” choose
Text (*.txt,*.dat). Select the file you want to import. Click
Open.

e A window will open called Text Import Wizard. Follow the

steps, depending on the ty%file you want to import.
STATCRUNCH

StatCrunch offers sever ays'to enter data. Click
MyStatCrunch > ck a dataset to analyze the data
or edit its propert

Click a data(se t

ta set.

lyze the data or edit its properties

te data into a form, or
pe or paste data into a blank data table.

or the “select a file on my computer” option, StatCrunch
offers a choice of space, comma, tab, or semicolon delimiters.
You may also choose to use the first line as the names of

the variables.

After making your choices, select the Load File button at the
bottom of the screen.

Credit Card Bank

Like all credit and charge card companies, this company makes money on each of
its cardholders’ transactions. Thus, its profitability is directly linked to card usage.
To increase customer spending on its cards, the company sends many different
offers to its cardholders, and market researchers analyze the results to see which
offers yield the largest increases in the average amount charged.

The dataset (Credit Card Bank) is part of a much larger database actually used
by the researchers. For each customer, it contains several variables in a spreadsheet.
Information on the variables is found in the file Credit Card Bank Info.

Examine the data in the data file. List as many of the W’ as you can for these
data and classify each variable as categorical or quantitative. If quantitative, identify
the units.
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EXERCISES

SECTION 1.2

1. A headhunter company collected information on a
group of job hunters. The first six applicants’ data appear
below. The columns correspond to the job hunter’s name,
gender, age, position applied to, earliest date of joining,
and salary expectation (in U.S. dollars).
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a) What does a row correspond to in this data table? How
would you best describe its role: as a participant, subject,
case, respondent, experimental unit, or something else?

b) How many variables are measured in each row?

Name Gender  Age  Position Applied
Patrick Martin M 35 Assistant Manager
Mohamad Leo Said M 25 Accountant
Miranda Scott F 20 | Junior Executive
Justin Phang Kok Min M 23 Management Officer
Chrystal Ng Jit F 18 General Clerk

| Siti Harley F 30 Sales Executive

N\

Earliest Joining Date = Year(s) of Experience = Expected Salary ($)
5/11/2020 8,000

6/1/2020 5,500
5/15/2020 3,000

8/1/2020 2 3,500

6/1/2020 0 2,800
5/11/2020 5 3,000 ]

2. Alocal bookstore is keeping a database of its customers
to find out more about their spending habits so that th

at does a row correspond to in this data table? How
would you best describe its role: as a participant, subject,
case, respondent, or experimental unit?
b) How many variables are measured for each case?

~\

Transaction ID ~ Customer ID SBN Number of Purchase Price Coupon? = Gift? = Quantity

29784320912 4)438 9 345-23-2355 $29.95 N N 1

26483589001 3K7 2009 983-83-2739 $16.99 N N 1

26483589002 3K729 /30/2009 102-65-2332 $9.95 Y N 1

3642948930, uo 12/5/2009 295-39-5884 $35.00 N Y 1

3642948930 3U034 12/5/2009 183-38-2957 $79.95 N Y 1
SECTION 1.3 SECTION 1.4

3. Referring to the headhunter company’s data table of
Exercise 1,

a) For each variable, would you describe it as primarily cat-
egorical, or quantitative? If quantitative, what are the units?
If categorical, is it ordinal or simply nominal?

b) Are these data a time series, or are these cross-sectional?
Explain briefly.

4. Referring to the bookstore data table of Exercise 2,

a) For each variable, would you describe it as primarily cat-
egorical, or quantitative? If quantitative, what are the units?
If categorical, is it ordinal or simply nominal?

b) Are these data a time series, or are these cross-sectional?
Explain briefly.

5. For the headhunter company data of Exercise 1, do
the data appear to have come from a designed survey or
experiment? What concerns might you have about draw-
ing conclusions from this data set?

6. A student finds data on an Internet site that contains
financial information about selected companies. He plans
to analyze the data and use the results to develop a stock
investment strategy. What kind of data source is he using?
What concerns might you have about drawing conclusions
from this data set?
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CHAPTER EXERCISES

For each description of data in Exercises 7 to 26, identify the
Ws, name the variables, specify for each variable whether its use
indicates it should be treated as categorical or quantitative, and
for any quantitative variable identify the units in which it was
measured (if they are not provided, give some possible units in
which they might be measured). Specify whether the data come
from a designed survey or experiment. Are the variables time
series or cross-sectional? Report any concerns you bave as well.

7. The news. Find a newspaper or magazine article in
which some data are reported (e.g., see The Wall Street
Fournal, Financial Times, Business Week, or Fortune). For the
data discussed in the article, answer the questions above.
Include a copy of the article with your report.

8. The Internet. Find an Internet site on which some data
are reported. For the data found on the site, answer as
many of the questions above as you can. Include a copy of
the URL with your report.

9. Survey. A four-star hotel provides a rating form to its
customers during their checkout to evaluate their satisfac-
tion with the hotel’s customer service, restaurant service,
bar service, room service, and housekeeping. The rating
scale is from 1 = very unsatisfied to 5 = very satisfied.

10. Product testing. A marketing department wants to
conduct a market research to know what customers think
about their new model of vacuum cleaner. The new vae-
uum model will be examined by collecting custome
feedback on first impressions, quality of product, ini
tiveness, and the value for money using the 5-poi

scale (1 = very bad to 5 = very good).

11. Evaluation. A company is using t
Performance Evaluation Excel templ
ExcelDataPro website (exceldat
uation-template) to evaluate its
the questions above for the fol
tion, evaluation purpose, review peri
interpersonal skills.

12. Pets’ meal. Based on the needs of pets sent to a vet-
erinary clinic, the clinic will provide each animal with dif-
ferent types of meals. The meals provide different amounts
of calories (in kcal), fats (in grams), proteins (in grams), and
fibers (in grams) that suits each individual pet.

13. Spending behavior. A study was conducted to investi-
gate the factors that influence students’ spending behav-
ior toward brand equity in the fashion industry. An online
questionnaire was circulated in Klang Valley, Malaysia.
The questions included specifying the sex of each respon-
dent; the age of each respondent; how strongly students
are aware of brand awareness, brand loyalty, and perceived
quality while making their fashion purchases.

14. Dining experience. A popular local café would like to
know about its customers’ dining experience and the sat-
isfaction levels related to the food quality, service quality,
and restaurant environment. A satisfaction feedback form
had been prepared for the customers to fill up while they
are paying their bill.

15. Planting. Two groups of plants were used in a study
in which one group is given fertilizer and the other is not.
If there are any differences between the fertilized plant
group and the unfertilized plant group, they may be due to
the addition of the fertilizer.

16. World Values Survey (WVS). To study changing values
and their impact on society and politics, the WVS (www
.worldvaluessurvey.org) has designed a cultural map of
the world, with nine cultural regions, such as Confucian
and Orthodox, instead of even continents. Countries
are also assigned numer res based on two major
dimensions of cross- alevariations: traditional values
versus secular-ratio alues and survival values versus
self-expression

A local farmers’ association hop-
tterfServices to its olive oil producers

18, OECD better life initiative. Established in Parisin 1961, the

rganization for Economic Cooperation and Development
(OECD) collects information on many economic and
social aspects of countries around the world. The OECD
Better Life Initiative is an attempt to compare well-being
across the OECD member countries. Central to this ini-
tiative is an interactive tool known as “Your Better Life
Index.” It lets one rank their country based on criteria such
as education, jobs, income, and work-life balance. Each of
these are described by one or more indicators. For exam-
ple, education is an average of scores that official statistics
assign to educational attainment, reading skills, and years
in education (www.oecdbetterlifeindex.org/).

19. EPA. The Environmental Protection Agency (EPA)
tracks fuel economy of automobiles. Among the data EPA
analysts collect from the manufacturer are the manufac-
turer (Ford, Toyota, etc.), vehicle type (car, SUV, etc.),
weight, horsepower, and gas mileage (mpg) for city and
highway driving.

20. Manufacturing. A solar panel manufacturing firm
conducts a study to determine whether their newly
designed solar panel would be cost competitive to their
current model. The manufacturer records the costs for
the materials, components, energy, machines, and labor
utilized.



21. Hair coloring. A hair coloring products company is
testing the quality and effectiveness of one of its newly
launched products. There are 50 participants involved in
the experiment of whom 25 have black hair and 25 have
white hair. The company records the gender, age, time
taken to color the participants’ hair, effectiveness of the
color on the participants’ hair, and the participants’ satis-
faction with the result.

22, Courier. LEX is a courier company that provides stan-
dard courier services, overnight courier services, same-day
express courier services, and international courier services.
Based on the type of service, LEX wants to determine the
accuracy of its delivery duration across different locations.
In order to do so, it retrieves delivery records from its
internal database.

23. Mobhile Apps. Kate is a mobile apps developer. She con-
ducts a survey to get feedback on her most recently devel-
oped mobile app in order to improve it. Her survey questions
cover the gender of each user, the age of each user, whether
the app runs smoothly or not, whether users like the app
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design, if it helps users achieve their goals, and if users would
recommend this app to their friends. Apart from specifying
their gender and age, user responses are based on a 5-point
Likert scale (1 = strongly disagree to 5 = strongly agree).

24. Health. A people’s association intends to know the
diet habits, physical fitness, and the kinds of exercise the
residents do in a particular state. A campaign has been
kick-started across the state to collect this information.

25. Taxi data. The market share analysis of rides in New
York City was based in part on the data from the New
York City Taxi and Limousine Commission. Data on each
ride can be found on the website www.nyc.gov/html/tlc/
html/about/trip_record_data.shtml. Because there are over
10,000,000 rides a month, the monthly files are large—up
to 2 GB each. For each ride they contain information on
the location, costs, a ate, among other variables. Here
are 13 columns and t 11rows (of 11,934,338!) for
Yellow Taxis in o t April 2016. (For a fascinating
analysis of taxidata ih New York and Chicago, visit the

er.com/)

p
TPEP_ TPEP_ Passenger_  Trip_ Pickup_
VendorlD =~ pickup dropof count distance = longitude

1 4/1/16 0:00 | 4/1/16 0:01 1 0.5 —73.97
1 4/1/16 0:00 | 4/1/16 0:12 2 22 3.
2 4/1/16 0:00 | 4/1/16 0:10 2 0.96 . 02
2 4/1/16 0:00 | 4/1/16 0:10 5 84856
2 4/1/16 0:00 | 4/1/16 0:00 2 —73:863739
1 4/1/16 0:00 | 4/1/16 0:15 —173.973373
1 4/1/16 0:00 —73.790092
1 4/1/16 0:00 0.6 —73.988899
2 4/1/16 0:00 0.81 —73.985275
1 4/1/16 0:00 | 4/1/16 0:04 1 0.8 0
1 4/1/16 0:00 | 4/1/16 0:06 2 1.8 —73.979752

-

ff_  Dropoff_ = Fare_ Tip_ Tolls_ = Total_

longitude latitude ~ amount amount amount amount
—73.977669 | 40.7539024 3.5 0 0 4.8

7572937 | —73.989288 | 40.7326584 10 2.25 0 13.55
40.7588692 | —73.990677 | 40.7513199 8.5 0 0 9.8
40.7677231 | —73.990829 | 40.7511864 8.5 1.96 0 11.76
40.7694702 | —73.976814 | 40.7752838 34 8.07 5.54 48.41
40.7570763 | —73.933472 | 40.766304 14 3 0 18.3
40.6470833 | —73.793915 | 40.6673737 13.5 0 0 14.8
40.7454262 | —73.991821 | 40.7384453 4.5 1.15 0 6.95
40.747364 '+ —73.985657 | 40.7550812 45 1 0 6.8
0 —73.977692 | 40.7538757 5 0 0 6.3
40.7809486 = —73.966621 | 40.8028374 1.5 0 0 8.8
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Plan to City
Purchase or Mobile
1D Age Car? Rural? = Device = Education

00001700-9f84-0134-2d50-0aaafcbdbblf | 29 yes city mobile high
0001a0c0-a08e-0134-cf68-0a62e1402143 | 39 yes city mobile high
000497f0-9efa-0134-9d13-0aaafcbdbh1f 19 no city mobile low
000501c0-badc-0134-49hc-0aeaf0818377 | 27 no city desktop = medium
0007a460-9ef0-0134-0666-0a62e1402143 | 35 yes city desktop | high
000861c0-a289-0134-30ba-0a62e1402143 | 53 no rural | mobile high
0008dbc0-acbe-0134-cb4a-0aaafchd6blf | 21 yes city tablet high
000920d0-9f42-0134-54fc-0aaafchd6blf | 19 no city mobile | high
000ae030-b561-0134-aeh9-0aaafchd6blf | 44 yes city mobile high
000ch8d0-9df1-0134-4a2a-0aaafchd6blf | 20 no city mobile high

|\

Household
Gender Latitude Longitude = Country Town Size Size
female 1.2855 | 103.8565 | Singapore | City with 5 million— = 4
10 million people
female | —12.0678 | —77.0886 @ Peru Town with 1 000— 5 or more
50 000 people
female | —33.0422 | —71.3733 | Chile City with 250 000~ ' 5 or more
1 million people
female 4.6492 « —74.0628 | Colombia  City with more than = 2
10 million people
female 41.0214 28.9684 | Turkey City with more than | 5 or more
10 million people
male 33.7208 | 130.6997 @ Japan Town with 1 000— 2
50 000 people
female 43.122 | —79.805 @ Canada City with 250 000— | 4
1 million people
female 3.0833 | 101.53 sia City with 50 000— 2
250 000 people
female 1.2855 3. gapore | City with 50 000— 2
250 000 people
female 1 5 Philippines | City with 250 000- | 3
1 million people

J

26. Dalia Research. The data set from Dalia Research
(you’ll learn more about Dalia in Chapter 2) contains
763 variables, including demographic information on the
43,034 respondents and survey questions on a varie

topics from intention to purchase a car to quantity of bottle
water consumption. Above is a small piece of that data

When you organize data in a spreadsheet, it is import
out as a data table. For each of these examples in
30, show how you would lay out these data. Indi
of columns and what would be found in eac

erformance:
’s social security
the borrower.

27. Mortgages. For a study of age |
loan number, last 4 digits of

number, amount of the loan, the n

28. Restaurant satisfaction. Data collected to determine
the customers’ satisfaction of a restaurant: receipt number,
age, quality of food rating (1-10), service rating (1-10),
cleanliness rating (1-10), and parking (1-10).

@ 29. Education in the Better Life Initiative. The OECD 2020
data file contains the following data related to education:
country name, educational attainment, student skills (aver-
age score), and years in education.

30. Company annual dinner. Data collected to identify
employees who are going to attend the company annual
dinner: Employee ID, department, bringing partner/
spouse (Yes / No), and vegetarian (Yes / No).

For the following examples in Exercises 31 to 34, indicate
whether the data are time series or cross-sectional.

31. Road accidents. Road accidents reported to the Royal
Malaysia Police in April 2020.

motor

to

34. Developments in well-being. The 2017 OECD Better
Life Initiative data for Spain in the second wave compared
to the OECD 2020 data of the first wave.

JUST CHECKING ANSWERS

<)

les by type in the year 2019.

rt registration. New monthly registrations of

OECD well-being. Comparison of the well-being indica-
in the OECD 2020 data file for 40 different countries.

1 The row refers to an order. You can tell because there is a
unique purchase order number (first column), but not
unique customers. Some customers made more than one
purchase.

2 Who—vpolicies on churches and schools

What—policy number, years claim free, net property
premium ($), net liability premium ($), total property value
($000), median age in ZIP code, school?, territory, coverage

How—company records
When—not given

3 Policy number: identifier (categorical)
Years claim free: quantitative
Net property premium: quantitative ($)
Net liability premium: quantitative ($)
Total property value: quantitative ($)
Median age in ZIP code: quantitative
School?: categorical (true/false)
Territory: categorical

Coverage: categorical





